CÂU HỎI LỚP 12 – HỌC KÌ I

Bài 1:







Câu 1: Cơ sở dữ liệu (CSDL) là :

A. Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính điện tử để đáp ứng nhu cầu khai thác thông tin của nhiều người dùng với nhiều mục đích khác nhau.
B.Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính điện tử.

C.Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được ghi lên giấy.

D.Tập hợp dữ liệu chứa đựng các kiểu dữ liệu: ký tự, số, ngày/giờ, hình ảnh... của một chủ thể nào đó.
Câu 2: Các công việc thường gặp khi xử lý thông tin của một tổ chức là ?
  A.  Tạo lập hồ sơ, cập nhật hồ sơ và khai thác hồ sơ    
  B. Sắp xếp, thống kê, tìm kiếm, lập báo cáo. 

  C.  Bổ sung, sửa chữa, xóa hồ sơ.         
  D. Tạo lập và cập nhật hồ sơ sổ sách.

Câu 3: Các công việc chính khi khai thác hồ sơ là:

  a) Sắp xếp, tìm kiếm, thống kê, lập báo cáo           c)  Sắp xếp, lập báo cáo, cập nhật hồ sơ

  b)Cập nhật hồ sơ, sắp xếp, tìm kiếm, thống kê       d)  Lập báo cáo, tìm kiếm, tạo hồ sơ
Câu 4:  Hệ quản trị CSDL là: 

     a) Là phần mềm cung cấp môi trường thuận lợi và hiệu quả để tạo lập, lưu trữ và khai thác thông tin của CSDL 

     b) CSDL và Hệ CSDL
     c) Là công cụ quản lý cơ sở dữ liệu của người dùng

     d) Là công cụ quản lý dữ liệu của người quản trị CSDL
Câu 5:  Điền từ còn thiếu: "Một cơ sở dữ liệu là một tập hợp các dữ liệu có liên quan với nhau, được lưu trữ trên ..............." ?

a) Bộ nhớ ngoài
            b)  Rom

c) CPU


d)  Ram

Câu 6: Phần mềm cung cấp môi trường thuận lợi và hiệu quả để tạo lập, lưu trữ và khai thác thông tin của CSDL được gọi là gì?


A).
Hệ quản trị CSDL 
B). Phần mềm

C). Ứng dụng

D). CSDL
Câu 7:  Người dùng có thể không quan tâm đến toàn bộ thông tin chứa trong CSDL mà chỉ quan tâm một phần nào đó thì được gọi là mức thể  hiện gì của CSDL?


A). Mức khung nhìn
B). Mức hỗn hợp

C). Mức khái niệm
D). Mức vật lí
Bài 2:

Câu 1. Ngôn ngữ định nghĩa dữ liệu giúp người dùng có thể:

A.  Cập nhật, tìm kiếm và khai báo cấu trúc

B. Cập nhật, tìm kiếm và kết xuất thông tin

C. Cập nhật, khai báo các kiểu và khai báo cấu trúc dữ liệu

D. Khai báo các kiểu, khai báo cấu trúc dữ liệu và các ràng buộc dữ liệu

Câu 2: Ngôn ngữ thao tác dữ liệu giúp người dùng có thể:

A. Khai báo các kiểu, khai báo cấu trúc dữ liệu và các ràng buộc

B. Cập nhật, tìm kiếm và khai báo cấu trúc

C. Cập nhật, tìm kiếm và kết xuất thông tin

D. Cập nhật, khai báo các kiểu và khai báo cấu trúc dữ liệu

Câu 3. Việc tạo lập một cơ sở dữ liệu của một tổ chức thường được tiến hành theo trình tự các bước sau:

A. Khảo sát, kiểm thử, thiết kế


C. Thiết kế, kiểm thử, khảo sát

B. Khảo sát, thiết kế, kiểm thử


D. Kiểm thử, khảo sát, thiết kế 

Câu 4. Hệ quản trị CSDL là:

A.Phần mềm dùng tạo lập CSDL

B. Phần mềm để thao tác và xử lý các đối tượng trong CSDL

C. Phần mềm dùng tạo lập, lưu trữ và khai thác một CSDL 

       D.Phần mềm dùng tạo lập, lưu trữ một CSDL
Câu 5:  Một hệ quản trị CSDL không có chức năng nào trong các chức năng dưới đây?

     A. Cung cấp công cụ quản lý bộ nhớ 

     B. Cung cấp môi trường tạo lập CSDL


     C.  Cung cấp môi trường cập nhật và khai thác

     D. Cung cấp công cụ kiểm soát truy cập CSDL
Câu 6: Nhóm người có nhiệm vụ phân quyền truy cập, đảm bảo an ninh cho hệ CSDL là:

       A. Người quản trị CSDL.


C.   Người quản lý.

       B.  Người dùng.



D.  Người lập trình ứng dụng.
Câu 7:  “ Tạo ra các chương trình ứng dụng đáp ứng nhu cầu khai thác của các nhóm người dùng” là vai trò của nhóm người nào?
A. Người lập trình ứng dụng.
B. Người quản trị CSDL.

C. Người dùng.

D. Người quản lý
Câu 8: Hệ quản trị CSDL có mấy chức năng chính?

A. 3 chức năng

B. 5 chức năng
C. 2 chức năng
D. 4 chức năng

Bài 3:
Câu 1. Trong Access, các chế độ làm việc với bốn đối tượng chính là:

A.  Chế độ thiết kế, chế độ trang dữ liệu, chế độ biểu mẫu

B.  Chế độ trang dữ liệu, chế độ biểu mẫu, chế độ thuật sỹ

C.  Chế độ biểu mẫu, chế độ thiết kế, chế độ thuật sỹ

D. Chế độ thiết kế, chế độ trang dữ liệu 
Câu 2: Để tạo một đối tượng mới trong Access, có thể dùng:


A. 4 cách                         B. 3 cách                        C. 2 cách                         D. 1 cách

Câu 3: Để thoát khỏi Access, ta thực hiện thao tác:

A. View/Exit

B. Edit/Exit

C. Tools/Exit

D. File/Exit

Câu 4: Trong Access, có mấy chế độ làm việc với các đối tượng ?
A. 2
                        B. 1
   
                 C. 3
                                        D. 4
Câu 5 : Hãy sắp xếp các bước sau để được một thao tác tạo CSDL mới ?

(1) Chọn nút Create                 (3) Nhập tên cơ sở dữ liệu

(2) Chọn File – New                 (4) Chọn Blank Database

A. (2) ( (4) ( (3) ( (1)                                       B.  (1) ( (2) ( (4) ( (3)

C. (2) ( (3) ( (4) ( (1)                                       D. (1) ( (2) ( (3) ( (4)
Câu 6:  thoát khỏi Access bằng cách:

A. Vào File (
 Exit

  

B. Vào File ( Close
C. Vào File ( Quit



D. Vào File ( Delete

Câu 7: Microsoft Access là gì?

A. Là hệ QTCSDL do hãng Microsoft sản xuất. 
B. Là phần cứng.


C. Là phần mềm hệ thống.         
                        D.  Là hệ thống phần mềm dùng tạo lập bảng.
Câu 8:  Các đối tượng cơ bản trong Access là:

A. Bảng, Báo cáo, Biểu mẫu, Mẫu hỏi.                B. Bảng, Macro, Biểu mẫu, Báo cáo.

C. Bảng, Mẫu hỏi, Biểu mẫu, Macro                    D. Bảng, Macro, Môđun, Báo cáo.
Bài 4:

Câu 1.  Thao tác nào sau đây không thuộc thao tác thay đổi cấu trúc bảng

A.  Thêm hoặc xoá trường

B.  Thay đổi khoá chính

C. Thêm hoặc xoá bản ghi

D. Thay đổi thứ tự trường

Câu 2.  Trong Access, tên trường không dài quá:

A.  255 kí tự

B.  164 kí tự

C.  127 kí tự

D. 64 kí tự

Câu 3.  Khi tạo bảng, tên các trường được gõ trong ô:

A.  Data Type

B. Field Name

C. Field Properties

D. Description

Câu 4.: Hãy nêu thao tác để chèn thêm một trường vào bảng:
A.
Insert/Rows

B.   Edit/Rows
C.
File/Insert Rows
D.  Edit/Insert Rows
Câu 5: Trong Access, khoá chính dùng để:

A.  Phân biệt hai trường với nhau trong một bảng

B.  Phân biệt hai bảng dữ liệu với nhau

C. Phân biệt hai hàng trong một bảng

D. Phân biệt hai thuộc tính với nhau trong một bảng

Câu 6: Trong cửa sổ CSDL, muốn tạo bảng bằng cách tự thiết kế, kích chọn thẻ Tables và  thực hiện:

A. Nháy đúp Create Table in Design view

B. Nháy đúp Create Table by using wizard

C. Nháy đúp Create Table for Design view
D. Nháy đúp Create Form by Design view

Câu 7: Giả sử, trường Email có giá trị là: 1234@gmail.com. Hãy cho biết trường Email có kiểu dữ liệu gì?

A.  Number

B.  Yes/No
C.  Currency

D. Text

Câu 8: Trong Access, khi nhập dữ liệu cho bảng, giá trị của trường GIOITINH là True hoặc False. Khi đó trường GIOITINH được xác định kiểu dữ liệu gì?
A. Text

B. Yes/No

C. True/False

D. Date/time
Câu 9: Trường dữ liệu kiểu Text nhập được tối đa bao nhiêu k‎‎ý tự 


A. 255


B. 525



C. 552


D. 65535

Câu 10:  Để thiết lập khoá chính cho một trường nào đó ta kích vào nút lệnh nào sau đây: 

A [image: image1.png]





B. [image: image2.png]






C. [image: image3.png]





D. [image: image4.png]



Câu 11: Dữ liệu của CSDL được lưu ở?


A.
Mẫu hỏi
B.
Biểu mẫu
C.
Báo cáo 
D.
Bảng
Câu 12: Khi làm việc với đối tượng bảng, muốn sửa đổi thiết kế cấu trúc bảng, ta chọn nút lệnh:


A. New                           B. Preview                      C. Design
                     D. Open

Câu 13: Khi nào có thể nhập dữ liệu vào bảng?

A. Sau khi bảng đã được tạo trong CSDL

B. Bất cứ khi nào có dữ liệu

C.Ngay sau khi CSDL được tạo ra

D. Bất cứ lúc nào cần cập nhật dữ liệu

Câu 14: Cấu trúc của một bảng được xác định bởi:

A. Các thuộc tính của đối tượng cần quản lí

B. Các trường và thuộc tính của nó

C. Các trường của bảng

D. Các bản ghi có trong bảng

Câu 15: Trong Access, dữ liệu kiểu ngày tháng được khai báo bằng từ

A. Day/Time

B. Date/Type

C. Date/Time

D. Day/Type
Câu 16: Để đổi tên bảng, sau khi chọn bảng cần đổi tên, ta thực hiện:
A. File/Rename


B. View/Rename

C. Insert/Rename

D. Edit/Rename

Câu 17: Để xóa một trường, sau khi chọn trường cần xóa, ta nháy chọn biểu tượng:
 A. [image: image5.bmp]


B. [image: image6.bmp]



C. [image: image7.bmp]


D. [image: image8.bmp] 

Câu 18: Để xóa một bảng, sau khi chọn tên bảng cần xóa, ta nháy chọn biểu tượng:
A.
[image: image9.bmp]

B. [image: image10.bmp]



C. [image: image11.bmp]


D. [image: image12.bmp] 

Câu 19: Khi làm việc với bảng, để thay đổi kích thước của trường, ta xác định giá trị tại dòng:
A. Field size 

B. Field name

C. Data Type

D. Description

Câu 20:  Khi chọn kiểu dữ liệu cho trường thành tiền (bắt buộc kèm theo đơn vị tiền tệ) , nên  chọn loại nào  

A  Currency

  B  Date/time             
         C  Number  

D  Text  
Câu 21: Khai báo cấu trúc cho một bảng không thực hiện công việc nào?

A. Nhập dữ liệu cho bảng


        C. Đặt tên trường.

B. Chỉ định kiểu dữ liệu cho mỗi trường.
         D. Khai báo kích thước của trường

Câu 22 : Khi đang làm việc với cấu trúc bảng, muốn lưu cấu trúc vào đĩa, ta thực hiện :
A. File  – Save

B. View – Save
                 C. Format – Save                    D.Tools – Save
Câu 23: Trong Access, kiểu dữ liệu số được khai báo bằng từ ?
A. Number
          B. Text
                 C. Memo
                           D. Curency
Câu 24: Trong Access, giá trị của trường GIOI_TINH là True/ False. Khi đó trường GIOI_TINH được xác định kiểu dữ liệu gì ?
A. Yes/No
            B. Boolean
                  C. Date/Time                          D. True/False
Câu 25: Khi làm việc với cấu trúc bảng, để xác định tên trường, ta gõ tên trường tại cột :
A. Field Name
            B. File Name
                  C. Name Field  
                 D. Name
Câu 26: Trong Access, muốn tạo cấu trúc bảng theo cách tự thiết kế, ta chọn
A. Create table in Design view
                            B. Create table by using wizard

C. Create table with Design view
                  D. Create table for Design view
Câu 27: Trong khi làm việc với cấu trúc bảng, muốn chèn thêm một trường mới, ta thực hiện :
A. Insert – Rows        B. Edit – Insert Rows          C. Tools – Insert Rows        D. File – Insert Rows
Câu 28: Trên Bảng ở chế độ thiết kế, thao tác chọn Edit ( Delete Rows ? 

A. Xoá trường hiện tại        


  B. Hủy khoá chính cho trường hiện tại

C. Tạo khoá chính cho trường hiện tại              D. Thêm trường mới vào trên trường hiện tại
Câu 29:  Trong Access các thao tác để xóa bảng là:

A. Chọn bảng cần xóa ( Edit ( Delete

      B.   Chọn bảng cần xóa ( Edit delete rows

C. Chọn Edit ( Delete



      D.   Chọn Record ( Filter ( Filter by form

Câu 30:  Để chỉ định trường khoá chính, ta chọn trường đó rồi nháy nút:

A. Primary key;
         B. Single key;
                 C. First key;
          D. Unique key;
Câu 31: Xoá trường, sau khi chọn trường cần xoá rồi thực hiện lệnh:
A. Vào menu Edit\Delete Row                              B. Vào menu File\Delete row
C. Tổ hợp phím Ctrl + Delete                                D. Tổ hợp phím Ctrl + D
Câu 32:  Khi làm việc với đối tượng bảng, muốn sử dụng chế độ thiết kế cấu trúc bảng, ta chọn nút lệnh :

A. Design
B. New
                 C. Preview 
           D. Open 
Câu 33 : Trong Access, dữ liệu kiểu ngày tháng được khai báo bằng từ ?
A. Date/Time
   B. Day/Type
                  C. Date/Type
 D. Day/Time
Câu 34:  Khi làm việc với cấu trúc bảng, để xác định kiểu dữ liệu của trường, ta xác định tên kiểu dữ liệu tại cột :
A. Data Type
    B. Description
                C. Field Properties
   D. Field Type
Câu 35:  Trong khi tạo cấu trúc bảng, muốn thay đổi kích thước của trường, ta xác định giá trị mới tại dòng :
A. Field Size          B. Field Name                    C. Description
          D. Data Type
Câu 36: Trong Access, nút lệnh này [image: image13.png]


 có ý nghĩa gì ?
A. Xác định khoá chính
                                   B. Khởi động Access
C. Cài mật khẩu cho tệp cơ sở dữ liệu               C. Mở tệp cơ sở dữ liệu_
Câu 37: Khi nào có thể nhập dữ liệu vào bảng :
A. Sau khi bảng được tạo trong CSDL.
B. Bất cứ khi nào có dữ liệu.


C. Bất cứ lúc nào cần nhập dữ liệu.
D. Ngay sau khi CSDL được tạo ra
Câu 38:Trong Access kiểu Text có độ dài là bao nhiêu kí tự?


A. 255 kí tự
B. 257 kí tự

C. 256 kí tự

D. 254 kí tự

Bài 5:

Câu 1: Để chuyển con trỏ sang trường bên phải cùng một hàng ta dùng:

A. Phím Tab

B. Phím Shitf + Tab

C. Phím Home

D. Phím Ctrl+Home

Câu 2: Để tìm kiếm trong hộp thoại Find And  Replace ta gõ cụm từ cần tìm vào ô:

A.  Match

B.  Find What

C.  Look in

D.  Search

Câu 3: Ta có thể thêm bản ghi mới bằng cách:

A.  Vào Edit\New record  

B.  Vào Tools\New record
C.  Vào Insert\New record
D.  Vào Format\ New record
Câu 4: Để xoả bản ghi, sau khi chọn bản ghi cần xoá,  ta có thể:

A.  Vào Format\ Delete
B.  Vào Tools\Delete
C.  Vào Fite\Delete
D.   Nhấn phím Delete
Câu 5: Cập nhật dữ liệu là thay đổi dữ liệu trong các bảng, gồm:
A.  Thêm, sửa và xoá bản ghi

B.  Sắp xếp thứ tự các bảng theo thứ tự tăng hoặc giảm

C.  Tìm kiếm một cụm từ thoả mãn điều kiện nào đó

D.  Lọc ra những bản ghi thoả mãn các điểu kiện nào đó

Câu 6: Để tìm kiếm bản ghi, sau khi đưa con trỏ lên bản ghi đầu tiên ta nháy:

A.  Crtl + H
B.  File \ Find

C.  Vào Edit\Find

D.  Cả ba cách trên đều sai
Câu 7: Khi tìm kiếm, có thể chọn tên bảng chứa cụm từ cần tìm trong ô:

A.  Find What
B.  Start of field 

C.  Match

D.  Look in 
Câu 8: Trong khi lọc theo ô dữ liệu đang chọn, nếu nháy chọn [image: image14.bmp]:
A.   Để huỷ lọc
B.   Để bắt đầu việc lọc 

C.  Để chọn điều kiện lọc
D.  Nhập  điều kiện lọc
Câu 9: Muốn thêm một bản ghi mới ta thực hiện

A.  Vào File\ New record

B.  Vào Edit\ New record\

C.  Vào Insert\ New record

D.  Vào Insert\record

Câu 10: Để lọc các bản ghi theo mẫu, ta thực hiện:

A.  Vào Format\ Filter \Filter by Form

B.  Vào Record\ Filter\Filter by Selection

C.  Vào Insert\ Filter\Filter by Selection
D. Nháy vào biểu tượng  [image: image15.bmp] trên thanh công cụ
Câu 11: Muốn cập nhật dữ liệu thì phải mở bảng ở chế độ:

A. Datasheet View                 B. View                    C. Form View
                D. Design View
Câu 12 : Thêm bản ghi mới :
A. Vào Insert\ New Record
                                B. Vào File\New Record

C. Vào Tool\New Record                                        D. Vào Edit\New record
Câu 13 : Trong Access, muốn xem lại trang dữ liệu trước khi in, ta thực hiện :

A. Tools – Print Preview
B. Windows – Print Preview

C. View – Print Preview
D. File – Print Preview
Câu 14: Cho biết ý nghĩa của nút lệnh [image: image16.png]


:

A. Lọc theo mẫu
B. Tìm kiếm
C. Lọc theo lựa chọn
D. Lọc/Hủy lọc

Câu 15: Cho biết ý nghĩa của nút lệnh [image: image17.png]


:

A. Lọc/Hủy lọc
B. Lọc theo lựa chọn
C. Lọc theo mẫu
D. Tìm kiếm

Câu 16: Nút lệnh nào có công dụng thêm bản ghi mới vào bảng:

A. [image: image18.png]



B. [image: image19.png]



C. [image: image20.png]



D. [image: image21.png]



Câu 17: Lệnh Insert\New Record tương đương với nút lệnh nào sau đây:

A. [image: image22.png]



B. [image: image23.png]



C. [image: image24.png]



D. [image: image25.png]



Câu 18: Cho biết ý nghĩa của nút lệnh [image: image26.png]


:

A. Lọc/Hủy lọc
B. Tìm kiếm
C. Lọc theo lựa chọn
D. Lọc theo mẫu
Câu 19:  Hãy cho biết ý nghĩa của nút lệnh [image: image27.png]


 , tương ứng với lệnh nào sau đây:

A. RECORD\SORT\SORT DESCENDING
B. RECORD\SORT  ASCENDING

C. RECORD\SORT\SORT ASCENDING
D. RECORD\SORT DESCENDING

Câu 20:. Hãy xho biết ý nghĩa của nút lệnh [image: image28.png]


 , tương ứng với lệnh nào sau đây:

A. RECORD\SORT \SORT\ASCENDING
B. RECORD\SORT ASCENDING

C. RECORD\SORT\SORT DESCENDING
D. RECORD\SORT DESCENDING
Câu 21: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn xóa bản ghi hiện tại, thao tác thực hiện lệnh nào sau đây là đúng

A. Edit/Delete Record
B. Delete
C. Insert/Column
D. Insert/New Record

Câu 22: .Để thực hiện thao tác tìm kiếm ta thực hiện lệnh nào?


A). Edit ( Find

B). Format ( Find

C). File ( Find
D). Tools ( Find

CÂU HỎI ÔN TẬP
Hãy chọn phương án đúng nhất trong các câu sau đây:

Câu 1: Các đối tượng cơ bản của Access là:

A.  Bảng, mẫu hỏi, biểu mẫu, báo cáo


C. Bảng, trường, bản ghi, báo cáo
B.  Bảng, Macro, biểu mẫu, mẫu hỏi


D. Bảng, hàng, cột, biếu mẫu 

Câu 2: Trong Access, khoá chính dùng để:

A.  Phân biệt hai trường với nhau trong một bảng     C. Phân biệt hai bảng dữ liệu với nhau

B.  Phân biệt hai hàng trong một bảng

       D. Phân biệt hai thuộc tính với nhau trong một bảng
Câu 3: Trong Access,  để tạo cơ sở dữ liệu mới, thao tác thực hiện nào sau đây là đúng?

A.  File/ Open/ <Tên tệp>

B.  Create table in Design View

C.  File/ New/ Blank Database

D.  Create table by using wizard

Câu 4: Trong cửa sổ CSDL, muốn tạo bảng bằng cách tự thiết kế, kích chọn thẻ Tables và  thực hiện:

A.  Nháy đúp Create Table by Design view

B.  Nháy đúp Create Table by using wizard

C.  Nháy đúp Create Table for Design view

D.  Nháy đúp Create Table in Design view

Câu 5: Dữ liệu của CSDL được lưu ở?


A.
Bảng
B.
Biểu mẫu
C.
Báo cáo 
D.
Mẫu hỏi

Câu 6: Để tạo một đối tượng mới trong Access, có thể dùng:


A. 4 cách                         B. 3 cách                        C. 2 cách                         D. 1 cách

Câu 7: Khi làm việc với đối tượng bảng, muốn sửa đổi thiết kế cấu trúc bảng, ta chọn nút lệnh:


A. New                           B.  Preview                    C. Design                   D. Open

Câu 8: Hãy nêu thao tác để xóa bớt một trường trong bảng:

A.
View/Delete Rows

B.   Delete Rows

C.
File/Delete Rows

D.  Edit/ Delete Rows 

Câu 9: Giả sử, trường giatien có giá trị là: 1.200 VND. Hãy cho biết trường giatien có kiểu dữ liệu gì?

A.  Text

B. Number
C. Yes/No

D. Currency
Câu 10: Trong Access, khi nhập dữ liệu cho bảng, giá trị của trường GIOITINH là Nam hoặc Nữ. Khi đó trường GIOITINH được xác định kiểu dữ liệu gì?

A. Yes/No

B. True/False

C. Text

D. Date/time

Câu 11: Thao tác nào sau đây thuộc thao tác thay đổi cấu trúc bảng

A. Thêm 2 bản ghi
B. Xoá 5 bản ghi   C. Thay đổi khoá chính    D.Xem nội dung bản ghi thứ 10

Câu 12: Trong Access, tên trường không dài quá:

A. 64 kí tự 

B. 127 kí tự

C. 164 kí tự

D. 255 kí tự

Câu 13: Một Hệ CSDL gồm:

A. CSDL và các thiết bị vật lí.


B. Các phần mềm ứng dụng và CSDL.

C. Hệ QTCSDL và các thiết bị vật lí.


D. CSDL và hệ QTCSDL để quản trị và khai thác CSDL.
Câu 14: Trong Access, Chế độ trang dữ liệu không cho phép thực hiện thao tác nào trong các thao tác dưới đây?

A. Xem các dữ liệu đã có.
B. Xóa dữ liệu đã có.

C. Thay đổi cấu trúc bảng.
D. Thay đổi dữ liệu đã có.

Câu 15: Muốn đổi tên bảng THISINH thành tên bảng HOCSINH ta thực hiện :

A. Nháy chọn tên THISINH / gõ tên HOCSINH.

B. Nháy phải chuột  vào tên THISINH/ Rename / gõ tên HOCSINH.
C. Trong chế độ thiết kế của bảng THISINH, gõ tên HOCSINH vào thuộc tính caption của trường chính.

D. File / Rename / gõ tên HOCSINH

Câu 16: Trong cửa sổ CSDL, muốn thay đổi cấu trúc 1 bảng ta chọn bảng đó rồi nháy:

A. [image: image29.png]& pesion




B. [image: image30.png]



C. [image: image31.png]hew




D. [image: image32.png]



Câu 17: Muốn chọn một trường làm khóa chính, ta nháy chọn trường đó và nháy chuột vào:

A. Biểu tượng  [image: image33.png]



B. Biểu tượng  [image: image34.png]



C. Biểu tượng  [image: image35.png]



D. Biểu tượng  [image: image36.png]



Câu 18: Mỗi đối tượng của Access có các chế độ làm việc là:

A. Trang dữ liệu và thiết kế


B. Chỉnh sửa và cập nhật


C. Thiết kế và bảng



D. Thiết kế và cập nhật

Câu 19: Dữ liệu trong một CSDL được lưu trong:

A. Bộ nhớ RAM.
B. Bộ nhớ ROM .
C. Bộ nhớ ngoài.
D. Các thiết bị khác.

Câu 20: Trong Access, tên trường được viết bằng chữ hoa hay thường?

A. Bắt buộc phải viết hoa
B. Tùy theo trường hợp

C. Bắt buộc phải viết thường
D. Không phân biệt chữ hoa hay thường.
Câu 21: Trong Access, dữ liệu kiểu boolean được khai báo bằng từ:

A. True/False

B.Yes/No

C.Date/Time

D.Text

Câu 22: Người nào có vai trò quan trọng trong vấn đề phân quyền hạn truy cập sử dụng CSDL trên mạng máy tính:

A. Nguời quản trị CSDL

B. Người dùng
C. Người lập trình

D. Cả ba người trên

Câu 23: Hệ Quản trị CSDL là :

A. Phần mềm cung cấp một môi trường thuận lợi và hiệu quả để tạo lập, cập nhật và khai thác dữ liệu.

B.Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được lưu trên máy tính điện tử.

C.Tập hợp dữ liệu có liên quan với nhau theo một chủ đề nào đó được ghi lên giấy.

D. Là các phần mềm có liên quan để tạo lập cơ sở dữ liệu.
Câu 24: Trong CSDL Quanli_HS.mdb, ta có thể chọn kiểu dữ liệu nào cho trường Tổ?

A. AutoNumber
B. Number
C. Yes/No
D. Currency

Câu 25: Đâu là kiểu dữ liệu văn bản trong Access?

A. Character
B. String
C. Memo
D. Currency

Câu 26: Trong Acess để tạo CSDL mới, thao tác thực hiện nào sau đây là đúng?

A. Create Table in Design View
B. Create table by using wizard

C. File/open
D. File/new/Blank Database.
Câu 27: Khi thay đổi cấu trúc bảng, Để chèn thêm một tr​ường mới vào bảng ta thực hiện.

A. File -> Column

B. Edit -> Column


C. View-> Column

D. Insert -> Rows
Câu 28: Trong Acess để mở CSDL đã lưu thao tác thực hiện lệnh nào sau đây là đúng:

A. File/new/Blank Database
B. Create table by using wizard

C. File/open/<tên tệp>
D. Create Table in Design View

Câu 29: Xét công tác quản lí hồ sơ, học bạ học sinh. Trong số các công việc sau, những việc nào không thuộc nhóm thao tác cập nhật hồ sơ?

A. Xóa một hồ sơ học sinh




B. Tìm các học sinh có điểm tin > 8.


C. Thêm hai hồ sơ
học sinh



D. Sửa tên học sinh trong một hồ sơ.

Câu 30: Thống kê, báo cáo thuộc công việc nào khi xử lý thông tin của một tổ chức?

A. Khai thác hồ sơ.
B. Tạo lập hồ sơ.
C. Cập nhật hồ sơ.
D. Tất cả đáp án

Câu 31: Nếu so sánh với một ngôn ngữ lập trình như Pascal thì ngôn ngữ định nghĩa dữ liệu tương đương với thành phần nào?

A. Các thủ tục nhập dữ liệu
B. Các thủ tục đóng/ mở tệp

C. Các công cụ khai báo dữ liệu
D. Cả ba thành phần trên 

Câu 32: Data Type có nghĩa là:

A. Độ rộng trưòng
B. Tên trường
C. Kiểu dữ liệu
D. Mô tả DL

Câu 33: Có các thao tác trong Access được đánh số như sau : 

1: Nháy đúp chuột vào Create table in design view
2: Chọn kiểu dữ liệu trong cột Data Type.

3: Nháy chọn đối tượng Tables



4: Lưu cấu trúc bảng.

5: Gõ tên trường vào cột Field Name


6: Mô tả nội dung trường trong cột Description.

7: Lựa chọn tính chất cho trường ở phần Field Properties
8: Chỉ định khóa chính cho bảng.

Trình tự nào sau đây dùng để tạo cấu trúc bảng?

A. 1 – 2 – 3 – 4 – 5 – 6 – 7 – 8.
B. 1 – 5 – 2 – 6 – 7 – 8 – 3 – 4.

C. 3 – 1 – 5 – 2 – 7 – 6 – 8 – 4.
D. 8 – 7 – 6 – 5 – 4 – 3 – 2 – 1

Câu 34: Việc xác định cấu trúc hồ sơ được tiến hành vào thời điểm nào :

A. Trước khi thực hiện các phép tìm kiếm, tra cứu ttin


B. Cùng lúc với việc nhập và cập nhật hồ sơ

C. Sau khi đã nhập các hồ sơ vào máy tính



D. Trước khi nhập hồ sơ vào máy tính
Câu 35: Trong khi làm việc với cấu trúc bảng, muốn xác định khóa chính, ta thực hiện : ......( Primary Key
A. Tools
B. Edit
C. File
D. Insert

Câu 36: Ngôn ngữ thao tác dữ liệu tác động lên yếu tố nào của đối tượng?

A. Dữ liệu
B. Cấu trúc.
C. Cấu trúc và dữ liệu
D. Không có đáp án đúng.

Câu 37: Đâu là một đối tượng trong Access?

A. Table.
B. Record.
C. Field.
D. Field name.

Câu 38: Cập nhật dữ liệu là thay đổi dữ liệu trong các bảng, gồm:

A. Sắp xếp thức tự các bản ghi theo thứ tự tăng hoặc giảm

B. Thêm, sửa và xoá bản ghi
C. Tìm kiếm một cụm từ thoả mãn điều kiện nào đó

D. Lọc ra những bản ghi thoả mãn các điểu kiện nào đó

Câu 39: Chức năng nào dưới đây không phải là chức năng của hệ QTCSDL?

A. Cung cấp môi trường tạo lập CSDL
B. Cung cấp môi trường khai thác thông tin của CSDL

C. Cung cấp thiết bị nhớ để lưu trữ CSDL
D. Cung cấp môi trường lưu trữ CSDL

Câu 40: Trong một CSDL, giả sử có một trường có dữ liệu là Tranphu@gmail.com ta có thể chọn kiểu dữ liệu gì cho trường đó?

A. Number.          B. Text.

C. Autonumber.

D. Date/time
